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#include <MD _TCS230.h>

#include <FreqCount.h>

#define BLACK CAL 0
#define WHITE CAL 1
#define READ VAL 2

// Pin definitions

#define S2 OUT 12

#define S3_OUT 13

#define OE_ OUT 8 //LOW =ENABLED
intled=7;

MD_TCS230 CS(S2_OUT, S3_OUT, OE_OUT);

void setup()
{ pinMode(led, OUTPUT);
digitalWrite(led, 0);
Serial.begin(57600);
Serial.print(F("\n[TCS230 Calibrator Example]"));
CS.begin();
H
char getChar()
// blocking wait for an input character from the input stream

{
while (Serial.available() == 0)

return(toupper(Serial.read()));

}

void clearInput()



// clear all characters from the serial input

{
while (Serial.read() !=-1)

}

uint8_t fsmReadValue(uint8_t state, uint8_t valType, uint8_t maxReads)
// Finite State Machine for reading a value from the sensor

// Current FSM state is passed in and returned

// Type of value being read is passed in

{
static uint§ t  selChannel;
static uint§ t  readCount;
static sensorData sd;
switch(state)
{

case 0:  // Prompt for the user to start
digitalWrite(led,0);

Serial.print(F("\n\nReading value for "));
switch(valType)
{
case BLACK CAL: Serial.print(F("BLACK calibration")); break;
case WHITE CAL: Serial.print(F(""WHITE calibration")); break;
case READ VAL: Serial.print(F("DATA"));

break;
default: Serial.print(F("??"));

break;
}

Serial.print(F("\nPress any key to start ..."));



case 1:

case 2:

state++;

break;

// Wait for user input
getChar();
clearInput();

state++;

break;

// start the reading process

digitalWrite(led,1);

case 3:

CS.read();

state++;

break;

// wait for a read to complete

if (CS.available())

sensorData sd;

colorData rgb;

switch(valType)

case BLACK CAL:

CS.getRaw(&sd);

CS.setDarkCal(&sd);

break;

case WHITE _CAL:

CS.getRaw(&sd);

CS.setWhiteCal(&sd);

break;

case READ VAL:

CS.getRGB(&rgb);

10



Serial.print(F("\nRGB is ["));
Serial.print(rgb.value[TCS230 RGB_R]);
Serial.print(F(","));
Serial.print(rgb.value[TCS230 RGB_GJ);
Serial.print(F(","));
Serial.print(rgb.value[TCS230 RGB_B]);

Serial.print(F("]"));

break;
}
state++;
digitalWrite(led,0);
}
break;
default:  // reset fsm
state = 0;
break;
h
return(state);
h
void loop()
{
static uint8_t runState = 0;
static uint8_t readState = 0;
switch(runState)
{

case 0: // calibrate black
readState = fsmReadValue(readState, BLACK CAL, 2);

if (readState == 0) runState++;

11



case 1:

case 2:

default:

break;
// calibrate white
readState = fsmReadValue(readState, WHITE CAL, 2);
if (readState == 0) runState++;
break;
// read color
readState = fsmReadValue(readState, READ VAL, 1);

break;

runState = 0; // start again if we get here as something is wrong

12
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#include <Servo.h>
Servo myservo;
void setup()

{
myservo.attach(9);
H

void loop()

{ myservo.write(0);
delay(1000);
myservo.write(90);
delay(1000);

myservo.write(180);

delay(1000);

}
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myservo.write(0);

delay(1000);
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myservo.write(90);

delay(1000);
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myservo.write(90);

delay(1000);
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3.4.2 115N INdIM3UIDINT VT UMM NVD UHSHTY
#include <Servo.h>

/*hl@a Color -> Arduino Uno

sO->3

sl ->4
s2->5
s3->6
LED ->7
out -> 8
Vcee > 5V

Gnd -> Gnd*/

//const int outputEnabled = 2; // write LOW to turn on Note, may not be hooked up.
const int s0 = 3; // sensor pins

const int s1 = 4;

const int s2 = 5;

const int s3 = 6;

//const int nLED = 7; // illuminating LED

const int out = 8; / TCS230 output

//const int 1outputEnabled = 2; // write LOW to turn on Note, may not be hooked up.
const int s02 = A3; // sensor pins

const int s12 = A2;

const int s22 = Al;

const int s32 = AO0;

//const int InLED = 7; // illuminating LED

const int out2 = 2; // TCS230 output



// variables to store color values
intred = 0;

int green = 0;

int blue = 0;

int gry=0;

// variables to store color values
int red2 = 0;

int green2 = 0;

int blue2 = 0;

int gry2 = 0;

int avg=0,avg1=0,avg2=0,avg3=0,avg4=0,stcoin=0;
Servo myservo,myservol; // create servo object to control a servo
void setup() {

myservo.attach(9);

myservo l.attach(10);

myservo.write(47);

myservo l.write(120);

//pinMode(outputEnabled, OUTPUT);

pinMode(s0, OUTPUT);

pinMode(s1, OUTPUT);

pinMode(s2, OUTPUT);

pinMode(s3, OUTPUT);

//pinMode(nLED, OUTPUT);

pinMode(out, INPUT);

//pinMode(1outputEnabled, OUTPUT);

pinMode(s02, OUTPUT);



pinMode(s12, OUTPUT);
pinMode(s22, OUTPUT);
pinMode(s32, OUTPUT);
//pinMode(nLED2, OUTPUT);

pinMode(out2, INPUT);

Serial.begin(9600);

//This pin may be set to ground and not available on the breakout
//If not available don't worry about it.
//digitalWrite(outputEnabled, LOW);
//Set Frequency scaling to largest value
digital Write(s0, HIGH);
digitalWrite(s1, HIGH);
digitalWrite(s02, HIGH);
digitalWrite(s12, HIGH);
//digitalWrite(nLED, LOW);
delay(1000);

h

void loop() {

// myservo.write(0);//pass

/| myservo.write(47);//stop

/| myservo.write(70);//no pass
// myservo1.write(160);//pass
/I myservol.write(90);//stop
myservo.write(47);//stop
myservo l.write(120);//pass
delay(200);

color();



gry=(red+green+blue)/3;
color1();

gry2=(red2-+green2+blue2)/3;

avg=0;
if(red>=28){avg+=1;}
if(green>=16){avg+=1;}

if(blue>=8){avg+=1;}

iflavg>=2) {Serial.print(" COIN ");
avg=0;

myservol.write(65);//stop
delay(200);

stcoin=0;

while(stcoin==0){

color();

gry=(red+green+blue)/3;

color1();

gry2=(red2+green2+blue2)/3;

Serial.println(gry, DEC);

Serial.println(gry2, DEC);
if(gry<19){Serial.print(" OK ");

avgl+=1;
iflavg1>3){avgl=0;avg2=0;avg4=0;avg3=0;}
avg3=0;

else{Serial.print(" NO OK ");

avg3+=1;

iflavg3>3){avg3=0;avg2=0;avg4=0;avg1=0;}
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avgl=0;

H

if(gry2<19){Serial.println(" OK ");

avg2+=1;

iflavg2>3){avg2=0;avg1=0;avg3=0;avg4=0;}

avg4=0;

}else{Serial.println(" NO OK ");

avg4+=1;

iflavg4>3){avgd=0;avg1=0;avg3=0;avg2=0;}

avg2=0;

}

iflavg1>=2 && avg2>=2){//passall
Serial.print(" pass ");
avgl=0;avg2=0;avg3=0;avg4=0;

myservo.write(0);//pass

delay(500);

myservo.write(47);//stop

delay(200);

stcoin=1;

H

if(avg3>=2 || avg4>=2){//no passall

Serial.print(" not pass");
avgl=0;avg2=0;avg3=0;avg4=0;

myservo.write(70);/no pass

delay(200);

myservo.write(47);//stop

delay(200);

stcoin=1;

}
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delay(500);
}
}

if(avg<=1){Serial.print(" NCOIN ");}

/%

Serial.print(red, DEC);

Serial.print(" ");

Serial.print(green, DEC);

Serial.print(" ");

Serial.println(blue, DEC);

Serial.print(red2, DEC);

Serial.print(" ");

Serial.print(green2, DEC);

Serial.print(" ");

Serial.println(blue2, DEC);*/

//if(gry<18){Serial.print(" OK ");}else{Serial.print(" NO OK ");}
//Serial.print(gry, DEC);

//if(gry<18){Serial.print(" OK ");}else{Serial.print(" NO OK ");}
//Serial.print(gry2, DEC);

//if(gry2<18){Serial.printIn(" OK ");}else{Serial.println(" NO OK ");}
//Simple logic to test for color

/*if (red < blue && red < green) Serial.println("Red");

else if (blue < red && blue < green) Serial.println("blue");

else Serial.printIn("'green");

*/

delay(300);

}
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void color() {

//digitalWrite(nLED, 1);

digitalWrite(s2, LOW);

digitalWrite(s3, LOW);

// count OUT, pRed, RED

red = pulseln(out, digitalRead(out) == HIGH ? LOW : HIGH);
digitalWrite(s3, HIGH);

//count OUT, pBLUE, BLUE

blue = pulseln(out, digitalRead(out) == HIGH ? LOW : HIGH);
digitalWrite(s2, HIGH);

// count OUT, pGreen, GREEN

green = pulseln(out, digitalRead(out) == HIGH ? LOW : HIGH);
//digitalWrite(nLED,0);

}

void color1() {

//digitalWrite(nLED2,1);

digitalWrite(s22, LOW);

digitalWrite(s32, LOW);

// count OUT, pRed, RED

red2 = pulseln(out2, digitalRead(out2) == HIGH ? LOW : HIGH);
digitalWrite(s32, HIGH);

//count OUT, pBLUE, BLUE

blue2 = pulseln(out2, digitalRead(out2) == HIGH ? LOW : HIGH);
digitalWrite(s22, HIGH);

// count OUT, pGreen, GREEN

green2 = pulseln(out2, digitalRead(out2) == HIGH ? LOW : HIGH);
//digitalWrite(nLED?2,0);

}
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M1yl 5un54 Arduino IDE

a

o o . 4 4 . . o
1. Mmsai Ivaa115unsy Arduino IDE 91899 hitp:/arduino.cc/en/Main/Softwareltaginmg

Y
anaalalsunsy

€ - X [ www.arduino.cc/en/Main/Software

ARDUINO

Home Buy Download Products » Learning -~ Forum Support » Blog LOG IN SIGN UP

Download the Arduino Software

Windows installer
ARDUINO 1.6.4 Windows zIP file for non admin install
The open-source Arduino Software (IDE) makes it easy to
write code and upload it to the board. Itruns on Mac OS X 10.7 Lion or newer
vs, Mac OS X, and Linux. The environment is
ten in Java and based on Processing and other open-

re.

OO

Linux 32 bits

are can be used with any.Arduino board Linux 64 bits
Refer to the Getting Started page for Installation
instructions. Release Notes
Source Code
Checksums

2. aand leneuveelilsunsy Arduino IDE #a31)

arduino



3. Wiola Tdsunsuudanz nunumia19ues IDE aegl

(FiR B el ot L e T ——

sketch_sep02a

Arduino Uno

: ¥ v o ¢ Aqu § ¢ & 9
4. 119 Tools->Board taaonliasanuuesanlsau Iasmonmu¥olosans1doans

Edit  Sketch lmﬂ Help. LY
ANO. Auto Format #T h_001 | Arduino 1.0.1 '
Archive Sketch

Fix Encoding & Reload

sketch_001 \ Serial Monitor o8M
Arduino Uno
Serial Port > Arduino Duemilanove w/ ATmega328
Arduino Diecimila or Duemilanove w/ ATmegal68
Programmer »  Arduino Nano w/ ATmega328

Burn Bootloader

Arduino Nano w/ ATmegal68

Arduino Mega 2560 or Mega ADK

Arduino Mega (ATmegal280)

Arduino Leonardo

Arduino Mini w/ ATmega328

Arduino Mini w/ ATmegal68

Arduino Ethernet

Arduino Fio

Arduino BT w/ ATmega328

Arduino BT w/ ATmegal68

LilyPad Arduino w/ ATmegal68

Arduino Pro or Pro Mini (SV, 16 MHz) w/ ATmega328
Arduino Pro or Pro Mini (5V, 16 MHz) w/ ATmegal68
Arduino Pro or Pro Mini (3.3V, 8 MHz) w/ ATmega328
Arduino Pro or Pro Mini (3.3V, 8 MHz) w/ ATmegal68
Arduino NG or older w/ ATmegal68

Arduino NG or older w/ ATmega8

54



= v 9 Y ' 2
5. L‘UEJ‘L!ITJ?!,Lﬂillﬂﬁ‘ljﬂﬂ’ﬂllﬂ1ua1\1u

Sf include the library code:
#include <LicuidCrystal.h>

/f initialize the library with the numbers of the interface pins

LirmidCrystal led(l2, 11, 5, 4, 3

void setup() {
/ set up the LCD's number of o
led.begin(lé, Z2):
/ Print a message to the LCD.
lediprint("hello, world!™);

vold loop () {
/{ set the curscr to column 0,
(note: line 1 is the second
led. setCursor (0, 1):
S/ print the number of seconds
led.print(millis() / 1000);

.
LR

olumns and rows:

line 1

row, since counting begins with 0):

since reset:

6. nnrunew I1ld 1Usunsulae 1 Sketch->Verify / Compile

£ sketch_zep02a | Arduino 10.1

File Ecit [Sketch) Took Help -

Verify / Compile

Show Sketch Folder
N Impogk Library...
Ay Add File.

ord loop || {

¢ print gut &

/ the setyp Loutines Iuns once whe, 3 pres= resst:
void setwpi) |
nitislixe =erial coomanics W00 bats per =ecund:
Serial.begin|9500) 2
L
the 1cOp EOUCINE Yim= OFer and over sgain LOTever:
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7. dlonewn rldGeudesaziidonuiingaagi

r@ sketch_sepl2s | Arduino LOL | B

Filo Edit Skstch Tools Hep

skelch_s2p023 §

wraxpl yde i3 1n owo EC. in.th.
¢ the astyp routipe rum# once when you press ressts
id setwp (| {
nitisliy periel coommicaticn atb S&0 1ts per aeconds
Serxal.negin(9600) ;
i
ke loap ¥ 1
ad loup|) |
3 ¥
Serfal.print({"Hello Vocld\u\x'™):

8 MMIIFOUADUDIA Arduino N3 1FNMANIAUADNAIADSHIUNIINOSH USB

bs 2]
| L Cmewme | ARDUINO

o
S e e

) e




] '
9. 911197 119 Tools->Serial Port ttaziaon 13

o 2 . ~ P
AINNUUDIA Arduino msﬂﬂmu

o [ o . [ o
(F1SUVDIA Arduino vous1 Tlsunsuazidenlion Tuaia)

r =
£ sketon_sepd2a | Arduino 10.1 [P
S S ————
Auto Format Cird=T
Archive Sketch
Fix Encoding & Reload
! Serial Monitar Ctrl+ Shife~ M %
Are B
‘ Bcard N -
h wpl
A P SenalPot » o CoME
‘ COMIE
Programmes
the setup v COMI9
14 getwp (| Burn Bootloader
i ielize serisl copmunioariy L e cond
Serial,begin|9600);
}
J the loop rourins rums OYer ar aver again rorevey
id oop()
/¢ prant out the walue you read:
Serial.print|"Hello Goridinyxr"):
1
Ardaing Uno on COMYE

10. TnaaTdsunsutuesa Arduino Nis11%911 Tae 11N File->Upload

€ sketch_sepd2a | Arduino 101
New

Open.

Sketchbook

Examnples

Clote

Save

Save 4z

Upload

Uplaad Using Programmir

Page Setup
Print

Preferences

Quit

Serfal.print("Nello Vo

Ll

Ctrie N
Ctar 0

Cti+W
Cri+S
Ctris Shift,
Ctriel)
Clits Shint

Ctris Shift+ P
CtrdsP

Ctd+Comma | agaln toreve

Ctr+ )

tldvnie”| s

» on COMIO

57



11. 911 ula Serial Monitor Y94 Arduino IDE Iﬂﬂ"lﬂﬁ Tools->Serial Monitor

@ sketch_Hello World | Arduin 1.0.1

(File Edic Sketch [Tools) Help

e )

Auta Format
Archive Sketch
HT allo_4 .
keteh_Hello_ Fix Encoding & Reload
Sesial Monitor
1)
Board
™ 1 <
Xy Senial Port
Programmer »
the set el
atd metep () Burn Bootloader [
) dnitialize eeris foation av 9500 bics y 1
Serial.begin(Ré00| ;
b
! the d un: J f
woLd Xoop() |
£/ prine ouc the walus you vesd:
Serdal.princ(“Bello Uorldyn\e"):
}
4 )

Arduin s Uno on L0

12. 1iforlla Serial Monitor 92 ladonueagll

,@ COM19

Hello
Hello
Hello
Hello
Hello
Hellno
Hello
Hello
Hello
Hellno
Hello
Hello
Hello
Hellno
Hello
Hello

World
World
World
World
World
World
World
World
World
World
World
World
World
World
World

[¥] Autoscral

iNoineendhg in?Eﬂﬂbaud

v
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= %4
aﬁﬂ’mﬁ]u Servo Motor 238 Arduino
{ o v @ ' 3 sy o &
Arduino 3 Taus13 11509911 RC Servo Motor i1 I uegud niluisnsuduiogiuaz1dau
] <} J . ' . .
1adre Tuniidlae http://ardumo.cc/en/reference/servoulﬁlclﬁjslgl}’f)ga‘HITIServo Library U9 Arduino
AWI5DANU RC Servo Motor 1A% sunuvyu l-ndu'ld 0-18089en (Mnandemudiedietiedu) wag
1 A = P ] . . = 1 9 J =
nuvaetilosnvyuasusoulaGeninili ContinuousRotation Servo (FaluzrsiieunauaznaIna
A A o 4 1 v o 4 o
AN Taed 115035095 UMSIF0UAD RCServo Motor TADY 12 @INUUBSA Arduino UNO 1Az 50951

gagana 48 dn1¥uesaArduino Mega

W&ﬁ%ﬂﬂ]ﬂju Servo Library
- attach()

- write()

- writeMicroseconds()

- read()

- attached()

- detach()

- attach()

Description
A s Aq Y o [ A 1T v . o Y
AoWanyu Nl¥lumsmriuau WIUN Servo Motor ADNU Arduino HAZNIUUAAIIUNIN

o A
GUENWﬁ“]fﬁ 0 93fLLae 180 a3

Syntax
Servo.attach(pin)

Servo.attach(pin,min,max)
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Parameters
. A o . g ¥ A ' v
Pin: A9 V1AYYI1UUDI Arduino nl4rouaony Servo Motor
v J 4 Y $ 1 a a
Min: A9 ANUNT1vINadhn 0 8armued Servo @an 14 lunie luTasIud (us) Tagndndinin
= 3/ 1 o 1 Sld'
Tusi msdaa Tdsunsuaziviuan 19N 544 us
o A o A [ a a
Max: A9 ANUNTUINATN 180 BaFNUDY Servo aan1F luriae'lu 1A% (us) Taoilndud)

12 3‘; 1 o 1 Sld'
win lidnsaaa Tdsunsuazmuuan 199 2400 us
Write()

Description
A dou  Aq Y ° v Ay Y o A o o
AoMandu N lduquamiandoans i Servo Motor nyu lildaesmnmuuaamnsomua
< ' Y A ' Ad . o o . < °
Wumesenldtae Ao 0-180 9971 1@ 1u Servo Motor M3l Full Rotation A4 write 324 UMIAMIUA
<
anuiz lumsnyu Tag
1 T W o @ Y
AN 90 AoA1F41# Servo Motor HEANLU
1 [ Y A 9 <3 a =
AUNINY 0 ABMIUYUAIIANUGIGIGA TUNANIINILS

1 [ Y 9 <3 a [
AUNINY 180 ﬁi’]ﬂ’liﬂlqlu@'gﬂﬂ')’lllﬁilg\‘]ﬁ;ﬂiuﬂﬁﬂ’]\“I@ﬁ\‘lﬂu"ﬁ}'lll

Syntax

servo.write(angle)

Parameters
A 9 v ' =
Angle: ﬂmpmﬁmmﬂw RC Servo Motor (LU 0-180 mﬁmagu"lﬂ 1A INIU RC Servo Motor

J o < a
11U Full Rotation A1 Angle ﬁ'ﬁ) mimwm]mmljmaz“V]ﬁmﬂumﬁ/iyu
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writeMicroseconds()

Description
A do g Y o 1 Aq v v o 1 A o ° <
Aofandu NlFaruaudnuian i Servo Motor vyu lgsdmmiisesenidvua Tasfmuaiu
1 9 v d ] =< a g 2 F) v A
AN INYoIAT IuUIe us B9nAuda Servo Motor 3 ldFanuniuesiadogh 1000-2000 us
1 1 1 1 § 1 1 A {
aud lanan ludreduuda ua Servo Motor 1193unse1serie bilaly sreanunieveswadawnla
! Y1 R < Yy oo . . LA v
na1e11dievz1drae 7002300 umunawnsolFlendu writeMicrosecondsilioinuan1IuN 19
Viad Ao
d o o J a g v
M5 15MandFu writeMicrosecondseuninmuuan laoase aseil “aesszialumsldan” win
v v S v
#9971 RC Servo Motor (U1 0 - 180 0371) dunyu liinugaduganonunads 0 w3e 180 oer aziild
a = [ 1 ] 9 4 a da! 9 = [ g‘/ é o Y
madesnseasnnmsuyuliae lilduazuomesaznunszuagaiudeslunanfernuiu Feer9hld

a v
RC Servo Motor Lﬂﬂﬂ'ﬂhlaﬂﬂ'lﬂvlﬂ

Syntax

servo.writeMicroseconds(uS)

Parameters

=) o

A 1 Y q.l 1 a = % .
uS: ﬂ@ﬂ?ﬂ’JnJﬂ’JN"ll’ENWﬁff‘l/lGl’E]Qﬂ1iﬂ1ﬁuﬂ1uﬂuﬂﬂqﬂiﬂiﬂu1ﬂ (I@]EJG]’JLHJ? int)

read()

Description
&Y 1 1 H < &Y 4 L) ] { ]
Aoflangu oumeosmidud ldredansu write() o ld Ndwmisesemgameimdad 1

9
v A0

v v 9
unliaui lvsgeamnemesnumivezliaregl uga 0180

Syntax

servo.read()
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Parameters
vl,ll'fl 9% Return A1 0-180

attached()

Description

A S ' A Y Yo o 1 ) o . A '
ﬂﬂﬁ\‘]ﬂ‘b'u A3IVFADUIN Servo WL?WQ@QﬂWﬁi‘FﬂWﬂQ@]@ﬂﬂQUﬂH Q)Jfl]u']ﬂ‘!sllf)\? Arduino ﬂiﬁlvlll

Syntax

servo.attached()

Parameters
[ [ 4 1 [ 1 I 1A
llllﬁ: 9% Return A1 True 890U 11N Servo Motor L%ﬂuﬁﬂﬂgﬂu Arduino um’ﬁmﬂ Return ’e]’e)ﬂ‘JJ”IL‘]Juﬂ”Iﬁu

A U " d‘ 1
o Lo usno
detach()

Description

Jd o ! o 3 o [ U
AoWandu Auaniuzvesnisidualiiluanaiugy Servo Motor A28f1d4 attached() InauABE NS
lay

Nuilng

Syntax

servo.detach()

Parameters

Taigi
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WanduveamaalUsunsy Arduino IDE NineIvo9

pinMode( x ,y );

A o & AAan Yo v o o L oAy Y Y o < A
ABDAE T]?Jlljﬁ'lﬁﬁﬂﬂ'lﬁuﬂﬂ’]ﬁvn\ﬂuéllﬂ\‘] pin ‘V]ﬂf)\‘]ﬂ’]ﬁcl“]f\ﬂu ElWV]']\?']ul‘]Jull‘UU OUTPUT %59 INPUT

o 3 [ o @ o I .
ﬂ13°l/|']\1']1‘l!flh! output }YU NITEI VYLIIAU 5 volt. ﬂﬁ‘vmm!,ﬂu mnput

iy msds Wewmanuzaing I Nillavieilang
pinMode(pin 19199713 19411, OUTPUT %30 INPUT);

digitalWrite( x , y );

A

A o & Yo o L Ay v Y a g
ADAN 11”1'3 TUUANTITNINIUUBN pln‘ﬂﬂi’)ﬁﬂWiGl“]N"Iu 1ﬁuﬁa1u$aa%ﬂLﬂul(HIGH

= 21PUTIAU 5 volt.) 150 0 (LOW = 1igadensaau 5 volt.)
.. . . Ay 9/ A
digitalWrite(pin NMeen1s 1991, HIGH v30 LOW),

delay( x);

Aomds ingan3v191u Ty Arduino AR IMUALATIAILEAINAA AT NEUHTI
3’, 9 = o Y ] Y ) I a =1

uazaIaaInal laaziden luszal millisecond uABINIHgAN T WA 1 33

]
1 A

mndoslalluitsdsudio 1000

[ { 3 o ] 3| Aa Aaa
delay@i 15 iludway Gnvisedlu Taaiuiii);
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3’, o Y ¢ = v v
6111-!61611!111!ﬂ“l‘iTlﬂﬂiQﬁiNﬂlﬂQQ‘lJﬂ‘Jmﬂﬂl!ﬂﬂlﬂiﬂ@!ﬂ“l-iﬁ%l

? = g o A @ @ .
1. ﬂluﬂﬂu‘l’llliﬂlﬂuﬂﬁ%ﬂmiElll‘Uf)iﬂthIﬂiﬂfJuTVlimaﬂi Arduino UNO R3

2. ‘I/Iﬂﬁﬁ]‘]Jﬂ’l'iﬁNTLJ‘llm‘Uf)gﬂ Arduino UNO R3 A1) Sensor RGB

F

65



I ) Py
3. @umsdasi luaa uag Useneusuay

66



£ 7 7 A
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http://www.arduinoall.com/product/155/%E0%B9%82%E0%B8%A1%E0%B8%94%E0%B8%B9%E0%B8%A5-%E0%B8%A7%E0%B8%B1%E0%B8%94%E0%B8%84%E0%B9%88%E0%B8%B2%E0%B8%AA%E0%B8%B5-%E0%B8%AD%E0%B9%88%E0%B8%B2%E0%B8%99%E0%B8%84%E0%B9%88%E0%B8%B2%E0%B8%AA%E0%B8%B5-rgb-colour-sensor-tcs230-tcs3200-%E0%B8%AA%E0%B8%B3%E0%B8%AB%E0%B8%A3%E0%B8%B1%E0%B8%9A-arduino-3
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